Problem:

A 1.5-in diameter steel countershaft supports two pulleys. Pulley A delivers power to a machine causing a tension of 600 lb in the tight side of the belt and 80 lb in the loose side of the belt as indicated. Pulley B receives power from the motor. The belt tensions on pulley B are $T_1 = 56$ lb and $T_2 = 446$ lb. Find the deflection of the shaft in the $z$-direction at pulleys A and B. Assume that the bearings constitute simple supports.
Countershaft

Overview

Anticipated time to complete this tutorial: 45 min.

Tutorial Overview
This tutorial is divided into six parts:
1) Tutorial Basics
2) Starting Ansys
3) Preprocessing
4) Solution
5) Post-Processing
6) Hand Calculations

Audience
This tutorial assumes minimal knowledge of ANSYS 8.0; therefore, it goes into moderate detail to explain each step. More advanced ANSYS 8.0 users should be able to complete this tutorial fairly quickly.

Prerequisites
1) ANSYS 8.0 in house “Structural Tutorial”

Objectives
1) Learn how to define keypoints, lines, and elements
2) Learn how to apply structural constraints and loads
3) Learn how to find the deflection of a part

Outcomes
1) Learn how to start Ansys 8.0
2) Gain familiarity with the graphical user interface (GUI)
3) Learn how to create and mesh a simple geometry
4) Learn how to apply boundary constraints and solve problems
In this tutorial:

- Instructions appear on the left.
- Visual aids corresponding to the text appear on the right.
- All commands on the toolbars are labeled. However, only operations applicable to the tutorial are explained.

The instructions should be used as follows:

- **Bold >** Text in bold are buttons, options, or selections that the user needs to click on

**Example:**  
> **Preprocessor > Element Type > Add/Edit/Delete File** would mean to follow the options as shown to the right to get you to the **Element Types** window

- **Italics** Text in italics are hints and notes

- **MB1** Click on the left mouse button
- **MB2** Click on the middle mouse button
- **MB3** Click on the right mouse button

Some basic ANSYS functions are:

To **rotate** the models use **Ctrl** and **MB3**.

To **zoom** use **Ctrl** and **MB2** and move the mouse **up** and **down**.

To **translate** the models use **Ctrl** and **MB1**.
For this tutorial the windows version of ANSYS 8.0 will be demonstrated. The path below is one example of how to access ANSYS; however, this path will not be the same on all computers.

For Windows XP start ANSYS by either using:

> Start > All Programs > ANSYS 8.0
> ANSYS

or the desktop icon (right) if present.

Note: The path to start ANSYS 8.0 may be different for each computer. Check with your local network manager to find out how to start ANSYS 8.0.
Once ANSYS 8.0 is loaded, two separate windows appear: the main ANSYS Advanced Utility Window and the ANSYS Output Window.

The **ANSYS Advanced Utility Window**, also known as the **Graphical User Interface** (GUI), is the location where all the user interface takes place.

The **Output Window** documents all actions taken, displays errors, and solver status.
The main utility window can be broken up into three areas. A short explanation of each will be given.

First is the **Utility Toolbar**:

From this toolbar you can use the command line approach to ANSYS and access multiple menus that you can’t get to from the main menu.

*Note: It would be beneficial to take some time and explore these pull down menus and familiarize yourself with them.

Second is the ANSYS **Main Menu** as shown to the right. This menu is designed to use a top down approach and contains all the steps and options necessary to properly pre-process, solve, and postprocess a model.

Third is the **Graphical Interface** window where all geometry, boundary conditions, and results are displayed.

The tool bar located on the right hand side has all the visual orientation tools that are needed to manipulate your model.
With ANSYS 8.0 open select 
  > File > Change Jobname
and enter a new job name in the blank field of the change jobname window.

Enter the problem title for this tutorial. 
  > OK

In order to know where all the output files from ANSYS will be placed, the working directory must be set in order to avoid using the default folder: C:\Documents and Settings.

  > File > Change Directory > then select the location that you want all of the ANSYS files to be saved.

Be sure to change the working directory at the beginning of every problem.

With the jobname and directory set the ANSYS database (.db) file can be given a title. Following the same steps as you did to change the jobname and the directory, give the model a title.
To begin the analysis, a preference needs to be set. Preferences allow you to apply filtering to the menu choices; Ansys will remove or gray out functions that are not needed. A structural analysis, for example, will not need all the options available for a thermal, electromagnetic, or fluid dynamic analysis.

> Main Menu > Preferences

Place a check mark next to the **Structural** box.

> OK

Look at the ANSYS Main Menu. Click once on the “+” sign next to Preprocessor.

> Main Menu > Preprocessor

The Preprocessor options currently available are displayed in the expansion of the Main Menu tree as shown to the right. The most important preprocessing functions are defining the element type, defining real constraints and material properties, and modeling and meshing the geometry.
The ANSYS Main Menu is designed in such a way that you should start at the beginning and work towards the bottom of the menu in preparing, solving, and analyzing your model.

*Note: This procedure will be shown throughout the tutorial.*

Select the “+” next to Element Type or click on Element Type. The extension of the menu is shown to the right.

> Element Type

Select Add/Edit/Delete and the **Element Type** window appears. Select add and the **Library of Element Types** window appears.

> Add/Edit/Delete > Add

In this window, select the types of elements to be defined and used for the problem. For a pictorial description of what each element can be used for, click on the Help button.

For this model, Elastic Pipe 16 elements will be used. We will define them as having a solid shaft rather than an inner diameter.

> Pipe > Elast straight16  
> OK

In the **Element Types** window, Type 1 Pipe16 should be visible signaling that the element type has been chosen.
The properties for the pipe 16 elements need to be chosen. This is done by adding a Real Constant.

> Preprocessor > Real Constants  
> Add/Edit/Delete

The Real Constants window should appear. Select add to create a new set.

> Add

The Element Type for Real Constants window should appear. From this window, select Pipe16 as the element type.

> Type 1 Pipe16 > OK

The Real Constant Set Number 1, for Pipe16 window will appear. From this window you can interactively customize the element type.

From the problem statement the outside diameter of the countershaft should be 1.5 inches. Since the shaft is a solid, the thickness of the elements should be equal to the radius of the outside diameter (0.75 inches).

Enter the values into the table as shown to the right.

> Ok

Close the window.

> Close
The material properties for the Pipe16 elements now need to be defined.

> Preprocessor > Material Props
> Material Models

The Define Material Models Behavior window should now be open.

This window has many different possibilities for defining the materials for your model. We will use isotropic, linearly, elastic, structural properties.

Select the following from the Material Models Available window:
> Structural > Linear > Elastic
> Isotropic

The window titled Linear Isotropic Properties for Material Number 1 now appears. This window is the entry point for the material properties to be used for the model.

Enter \( 30 \text{e6} \) (30 Mpsi) in for \( E \) (Young’s Modulus) and 0.3 for \( PRXY \) (Poisson’s Ratio).

> OK

Close the Define Material Model Behavior window.
> Material > Exit
The next step is to define the keypoints (KP’s) where loads and constraints will be applied:

> Preprocessor > Modeling
> Create Keypoints > In Active CS

The Create Keypoints in Active CS window will now appear. Here the KP’s will be given numbers and their respective (XYZ) coordinates.

Enter the KP numbers and coordinates for the shaft definition. Select Apply after each KP has been defined.

Note: Be sure to change the keypoint number every time you click apply to finish adding a keypoint. If you don’t it will just move the last keypoint you entered to the new coordinates you just entered.

KP # 1: X=0, Y=0, Z=0  
KP # 2: X=12.0, Y=0, Z=0  
KP # 3: X=33.0, Y=0, Z=0  
KP # 4: X=48.0, Y=0, Z=0

Select OK when complete.

In the case that a mistake was made in creating the keypoints, select:
> Preprocessor > Modeling > Delete
> Keypoints

Select the inappropriate KP’s and select Ok.

The created KP’s should look similar to the example to the right, except the KP’s could be labeled with the KP numbers.
At times it will be helpful to turn on the key-
point numbers.

> PlotCtrls > Numbering > put a checkmark next to keypoint numbers > OK

Other numbers (for lines, areas, etc.) can be turned on in a similar manner.

The next step is to create lines between the KP's.

> Preprocessor > Modeling
> Create > Lines > Lines
> Straight Lines

The Create Straight Line window should appear. You will create 3 lines. Create line 1 between the first two keypoints.

For line 1: MB1 KP1 then MB1 KP 2.

The other lines will be created in a similar manner.

For line 2: MB1 KP2 then MB1 KP 3.
For line 3: MB1 KP3 then MB1 KP 4.

Verify that each line only goes between the specified keypoints. When you are done creating the lines click ok in the Create Straight Lines window.

> Ok

If you make a mistake, use the following to delete the lines:

> Preprocessor > Modeling > Delete
> Lines Only
Now that the model has been created, it needs to be meshed. Only meshed models can be run to find a solution. Models are meshed with elements.

First, the element size will be specified.

> Preprocessor > Meshing
> Size Cntrs > Manual Size
> Lines > All Lines

The **Element Sizes on All Selected Lines window** should appear. From this window the number of elements per line segment can be defined, along with the Element edge length.

Since the length of the shaft is 48 in, approximately 240 elements along the length of the shaft will produce reasonable results. 240 was chosen simply because it divides evenly into 48.

Enter **0.2** into the **Element edge length** field since \( \frac{48}{240} = 0.2 \text{ in.} \)

> Ok

Note: you could change the element edge length after completing the tutorial to a different value and rerun the solution to see how it affects the results.

With the mesh parameters complete, the lines representing the shaft can now be meshed. Select:

> Preprocessor > Meshing > Mesh
> Lines

From the **Mesh Lines window** select Pick All.

> Pick all

This will select all the line segments and mesh them all at the same time. The meshed shaft will appear as a single blue line.
We will now move into the solution phase.

Before applying the loads and constraints to the beam, we will select to start a new analysis:

> Solution > Analysis Type  
> New Analysis

For **type of analysis** select **static** and select **OK**.

The forces and constraints will now be added. It will be easier to select the keypoints (the locations of the forces and constraints) if the keypoint numbers are turned on as previously explained. However, the current view probably shows just the elements and not the keypoints. You can see both the elements and the keypoints on the screen by selecting:

> Plot > Multiplots

To see just the keypoints;

> Plot > Keypoints > Keypoints

Use the plot menu to view your model in the way that will make it easier to complete each step in tutorial.

To apply constraints select:

> Solution > Define Loads > Apply  
> Structural > Displacement  
> On Keypoints

The **Apply U, ROT on KP’s window** now appears.
With the **Apply U, ROT on KP’s window** open, select **KP 1** and **KP 4** from the ANSYS graphics window.

> **Apply**

The **Apply U, ROT on KP’s large window** should appear. From this window the degrees of freedom can be specified.

To the right of **DOFs to be constrained** select **UZ**.

> **OK**.

The constraints now appear at keypoints 1 and 4.

The loads will now be applied to the shaft.

> **Solutions > Define Loads > Apply**
> **Structural > Force/Moment**
> **On Keypoints**

The **Apply F/M on KP’s window** should appear.

Select **KP 2** in the graphics window.

> **Apply**

The expanded **Apply F/M on KP’s window** should appear. From this window the direction of the force and magnitude can be specified.

Select **FZ** for the Direction of force/mom. Select **Constant Value** for Apply as.

Enter 680 (600lb + 80lb = 680lb) in the **Force/moment** value field which will apply a 680 lb force.

Verify that all the fields match those of the figure shown to the right.

> **Apply**
With the **Apply F/M on KP’s window** still open select **KP 3** in the graphics window.

> Apply

The expanded **Apply F/M on KP’s window** should appear. From this window the direction of the force and magnitude can be specified.

Select **FZ** for the direction of force/moment. Select **Constant Value** for Apply as.

Enter **-502** ($446\text{lb} + 56\text{lb} = 502\text{lb}$) in the **Force/moment** value field which will apply a **502 lb force** in the negative z direction.

Verify that all the fields match those of the figure shown to the right.

> OK

The model is fully constrained and all the loads are applied. A picture is shown below.
Before proceeding, turn on the 3D view of the model elements.

> Plot Controls > Style
> Size and Shape

The Size and Shape window opens. Click the check box next to Display of element to turn on the 3D image.

> OK
The next step in completing this tutorial is to solve the current load step that has been created. Select:

> Solution > Solve > Current LS

The **Solve Current Load Step** window will appear. To begin the analysis select **OK**.

If a **Verify** window appears telling that the load data produced 1 warning, just select **Yes** to proceed with the solution.

The analysis should begin and when complete a **Note** window should appear that states the analysis is done.

Close both the **Note window** and **/STATUS Command window**.

If your model is still in the 3-D view use the view icons on the right of the screen to bring the model to a front view again.
Results are viewed by using post processing commands.

For this problem the results viewer will be used to view the solution.

> General Postproc
> Results Viewer

The screen now changes to the results viewer mode and the Results Viewer window appears.

Click the down arrow to the right of Choose a result item.

In the drop down menu select:
> Nodal Solution > DOF Solution
> Z - Component of displacement

A graphical representation of the displacement at each node is displayed. The max displacement is shown as .037718 (SMX). We are not looking for the max displacement, but the displacements at A and B.
To find the displacements at A and B in the z direction, we need to know the node numbers at A and B and then the corresponding displacements. In the Results Viewer window, click on the List Results button.

A window called the PRNSOL Command appears listing the nodes and their displacements. Leave this window open, but close the Results Viewer window (this will also exit the results viewer mode).

Now select the following from the utility menu at the top of the screen:

> List > Nodes

The Sort node listing window now appears. Select the coordinate only option and click ok.

> OK

A window now appears showing the nodes and their x,y,z coordinates.

Scroll through the list and find the number of the nodes that are located at \( x = 12 \), and \( x = 33 \).

Your solution may be different, but in this case, the node at \( x = 12 \) is node 1 and the node at \( x = 33 \) is node 62.

Now look up the displacements for this nodes in the PRNSOL Command window which should still be open.

Node 1 has a z - direction displacement of about 0.037 in.

Node 62 has a z - direction displacement of about 0.0045 in.

This means the displacement at A is 0.037 in and the displacement at B is 0.0045 in.
Torque = (600 - 800)*(9/2) = 2340 lb-in
(T2 - T1)*12/2 = T2 (1 - .125)*6 = 2340
T2 = 2340/(6*.875) = 446 lb
T1 = .125*446 = 56 lb

First, consider the 680 lb load as acting alone.
ZOA = -Fbx*(x² + b² - l²)/(6EIl); where b = 36", x = 12", l = 48", F = 680 lb.
I = \(\pi d^4/64 = .249 \text{ in}^4\)
Z_A = -680*36*12*(144+1296 -2304)/(6*30*10^6*.249*48) = .0117 in

ZAC = -Fa*(l-x)*(x² + a² - 2lx)/(6EIl); where a= 12", x = 33", l = 48", F = 680 lb.
I = \(\pi d^4/64 = .249 \text{ in}^4\)
Z_B = -680*12*15*(1089+225 -3168)/(6*30*10^6*.249*48) = -.110 in

Next, consider the 502 lb load as acting alone.
ZOB = Fbx*(x² + b² - l²)/(6EIl); where b= 15", x = 12", l = 48", F = 502 lb.
I = \(\pi d^4/64 = .249 \text{ in}^4\)
Z_A = 502*15*12*(144+225 -2304)/(6*30*10^6*.249*48) = -.0812 in

ZBC = Fbx*(x² + b² - l²)/(6EIl); where b= 15", x = 33", l = 48", F = 502 lb.
I = \(\pi d^4/64 = .249 \text{ in}^4\)
Z_B = 502*33*15*(1089+225 -2304)/(6*30*10^6*.249*48) = -.114 in

Therefore, by superposition
Z_A = .0117 - .0812 = .0367 in
Z_B = .110 - .114 = .004 in